# Table of Contents

Welcome to TSP 303 ........................................................................................................ 5
1 Conventions used in this manual .............................................................................. 5
2 Software licence agreement ..................................................................................... 6
3 Software installation / licensing .............................................................................. 6
   3.1 System requirements ....................................................................................... 6
   3.2 Software installation ....................................................................................... 6
   3.3 Software updates ........................................................................................... 7
   3.4 Software uninstallation ................................................................................. 7
4 Licensing .................................................................................................................. 7
   4.1 Hardkey version ............................................................................................. 7
   4.2 Softkey version ............................................................................................. 7
   4.3 License tool .................................................................................................... 8
   4.4 License upgrade ............................................................................................. 8
1 Safety directions ....................................................................................................... 11
   1.1 Disclaimer of liability .................................................................................... 11
   1.2 Use of instrument ......................................................................................... 11
      1.2.1 Intended use of instrument ..................................................................... 11
      1.2.2 Prohibited uses .................................................................................... 11
      1.2.3 Limits of Use ....................................................................................... 11
      1.2.4 Prohibited modifications ...................................................................... 12
      1.2.5 Danger working within tunnel environment ......................................... 12
      1.2.6 Other dangers ..................................................................................... 12
2 TSP 303 Plus system components ........................................................................... 13
3 Preparing a TSP measurement ................................................................................ 17
   3.1 General .......................................................................................................... 17
   3.2 Marking of the measurement layout ............................................................... 17
   3.3 Drilling and protecting bore holes ................................................................... 18
   3.4 Check list of required items ......................................................................... 18
4 Performing a TSP measurement ............................................................................. 21
   4.1 Measuring of the layout geometry .................................................................. 21
   4.2 System setup .................................................................................................. 25
      4.2.1 Assembling receiver .............................................................................. 25
      4.2.2 Checking receiver bore holes ............................................................... 28
      4.2.3 Setting the receiver .............................................................................. 30
      4.2.4 Connecting Toughbook with Recording Unit ...................................... 36
      4.2.5 Checking battery charge ....................................................................... 36
      4.2.6 Use of external batteries ....................................................................... 37
      4.2.7 Seismic noise test ............................................................................... 37
      4.2.8 Trigger/Shot test (Trigger mode Standard) ........................................... 38
      4.2.9 Charge configuration .......................................................................... 38
      4.2.10 Detonator preparation & system setup ............................................... 39
4.3 Seismic data acquisition ..................................................................................... 47
   4.3.1 Amberg TSP Plus Workspace .................................................................. 47
   4.3.2 Amberg TSP Plus Menus & Tool bars ..................................................... 48
   4.3.3 Starting data acquisition ........................................................................ 49
   4.3.4 Acquisition wizard ................................................................................ 50
   4.3.5 Data recording ......................................................................................... 56
4.4 Dismounting the receiver .................................................................................... 58
5 System maintenance ............................................................................................... 61
   5.1 Charging Batteries ......................................................................................... 61
5.2 Cleaning of system components ......................................................... 61
6 Disposal ................................................................................................. 63
  6.1 Disposal of TSP components .......................................................... 63
  6.2 Disposal of batteries and accumulators ......................................... 63
7 Declaration of Conformity ................................................................. 65
Welcome to TSP 303

Congratulations on purchase of the TSP 303 system.

From the use of innovative technologies a more rapid construction of extremely complex underground structures is possible. Examples might be the use of tunnel boring machines, with advance rates of up to 20 m or more each day, or advanced drill and blast techniques. In either case, the safety and progress of the project is based on the assumed knowledge of the rock's properties ahead of the face. Exploratory drilling from the tunnel face is often used to detect lithologic heterogeneities ahead of the tunnel face but the maximum predictive range of this method is only about 50 m and it entails significant delays to excavation.

The Tunnel Seismic Prediction TSP®, a rapid, non-destructive and highly sophisticated measuring system is especially designed for underground construction works. The TSP® method was first introduced to the underground construction market in 1994. Since then it has been successfully used on more than 1,000 underground projects worldwide.

TSP 303 is a ready to use system to measure seismic reflected waves and to evaluate geology ahead the tunnel face. The goal is to predict unforeseen changes in rock conditions which too often cause unnecessary costly downtime and problems.

This Method provides:

- A prediction of major changes in the rock mass both ahead and surrounding the tunnel face in a three-dimensional image
- The evaluation of mechanical properties of the rock ahead of the face.

In most rock formations the TSP® method can provide data up to 150 m ahead of the face and in hard rock even more than 200 m. The TSP 303 system of Amberg Technologies AG builds on the experience and features of the already proven TSP® 202 and TSP® 203 systems. TSP 303 software can acquire, process and evaluate data all within the common Microsoft Windows interface. It is now possible, for example, to determine the distribution of the rock's mechanical parameters, such as elastic Moduli and Poisson's ratio, for the entire area under investigation within a 3D space. With this information it is possible to recommend suitable measures to reinforce weak rock zones for maximum safety and optimum advance rates. Amberg Technologies AG has invested its considerable knowledge and experience into the development of this system. We are sure you will enjoy its high standard of accuracy, user friendliness and ease of handling and we wish you many successful projects using this equipment in future.

Please read this manual carefully together with enclosed operating instructions of accessories before working with the equipment.

Please consider the safety references.

1 Conventions used in this manual

Since errors in the manual and in the program cannot possibly be prevented with absolute certainty, Amberg Technologies AG is always grateful for comments and feedback. The circumstances and location involved when an error occurred should be described as accurately as possible.

Information to prevent injury to yourself when trying to complete a task.
Information to prevent damage to the components when trying to complete a task.

Information that you must follow to complete a task.

Additional information.

Information using features efficiently.

2 Software licence agreement

You can find the software license agreement under the following link:

http://www.ambergtechnologies.ch/license-agreement

3 Software installation / licensing

This section describes the installation of the software and its components.

3.1 System requirements

The table below shows computer specifications necessary for the data processing

<table>
<thead>
<tr>
<th>Table 1. System requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating system</td>
</tr>
<tr>
<td>RAM</td>
</tr>
<tr>
<td>Hard disk capacity</td>
</tr>
<tr>
<td>Processor</td>
</tr>
<tr>
<td>Printer</td>
</tr>
</tbody>
</table>

For the data collection it is recommended to use the Panasonic Toughbook delivered with the system. Other computers are not supported by Amberg Technologies. Do not run any other software on the measuring computer as required. Switch off any firewall and other security based software (virus scan, etc.). OS Windows XP and Windows Vista are not being supported.

3.2 Software installation

3.2.1 Latest software release

The latest software release of Amberg TSP Plus will be delivered with the purchase of the system or can be downloaded on our home page

www.ambergtechnologies.ch/downloads

3.2.2 Installation

The Amberg TSP Plus program is supplied as install executable in compressed form. The program can only be used on the hard-disk after it has been installed.
The procedure is as follows:

1. Install the program from the delivered media.
2. If you have downloaded the program from the Internet, unzip the file to an empty directory and double-click on the file `Amberg TSP Plus xxx.exe`.
3. Follow the instructions during the installation.

When you have a full license of the software, you must additionally install the drivers for the license Hardkey/Softkey.

### 3.3 Software updates

Whenever there is a new release of the software Amberg TSP Plus, simply install it according to the instructions. You have access to the download page and to software update an case of a valid maintenance contract.

### 3.4 Software uninstallation

Please use the function "Uninstall Amberg TSP Plus" to uninstall the software from your operating system.

Please remember, that only files, which have not been modified since installation, can be uninstalled. This means that data files can eventually not be uninstalled automatically. They need the be deleted manually (e.g. with Explorer).

### 4 Licensing

For access to the full functionality of the TSP 303 data acquisition, two types of license keys are supported, Hardkeys and Softkeys. Hardkeys are integrated in the Recording Unit, while Softkeys are being embedded in the Windows registry of the delivered Toughbook PC. From model year 2015 on, the TSP 303 Plus system is shipped with Softkeys on your Toughbook PC with regard to Data Acquisition.

#### 4.1 Hardkey version

The TSP 303 Recording Unit is supplied with a Hardkey. The serial number can be seen under Help ▶ About Amberg TSP Plus or under Help ▶ License tool... This only works, if the Recording Unit is connected with the Toughbook PC. The connected Hardkey is indicated by .

##### 4.1.1 Installation of Hardkey drivers

Disconnect Toughbook from Recording Unit. Switch on the Toughbook PC. Install the Amberg TSP Plus installation executable. Dongle drivers are installed together with the application.

The installation of any application only works with administrator rights. Please install the application only, when the Toughbook is offline from the Recording Unit. Otherwise, the Hardkey can be damaged.

#### 4.2 Softkey version

The application Amberg TSP Plus is supplied with Softkey Certificates. The Certificates number can be seen under Help ▶ About Amberg TSP Plus or under Help ▶ License tool... Registered certificated are indicated by .
4.2.1 Installation of Softkey drivers

Disconnect Toughbook from Recording Unit. Switch on the Toughbook PC. Install the Amberg TSP Plus application. Softkey drivers are installed together with the application.

4.3 License tool

To view and upgrade the licenses on the Hardkey/Softkey the separate license tool can be used. To start the license tool, select Help ▶ License tool....

4.3.1 License viewer

The license viewer displays a list of all Hardkeys/Softkeys which are available on the present device and the features licensed on these keys. To see the licensed features of a Hardkey/Softkey, expand its feature entries by clicking on the small triangle next to the visible key name.

4.4 License upgrade

A license upgrade is possible at any time, e.g. for having access to additional hardware and acquisition features. The license upgrade progress is equal for Hardkeys and Softkeys

Upgrades will only be provided after purchase of license extensions or new licenses.

4.4.1 Creating a c2v file

Client-to-vendor (.c2v) files are used to transfer information of a Hardkey/Softkey from the software user to the software vendor. Amberg Technologies may ask you for sending this file to be able to upgrade your Hardkey/Softkey with new licensed features or extend the licensing period of already licensed features.

To create a c2v file, right-click on the entry of the Hardkey/Softkey for which the c2v file should be created. From the context menu select Create c2v file and specify the location where it should be stored. Send the created Client to vendor files (.c2v) to <support.geophysics@amberg.ch>.
4.4.2 Updating from a v2c file

Vendor-to-client files (.v2c) are used to update a Hardkey/Softkey on the software user client with new licenses, extend license periods or update licensed features. Amberg Technologies will send you such a file in the process after purchasing license extensions or new licenses.

To update a Hardkey/Softkey from a v2c file, right-click on the entry of the Hardkey/Softkey that should be updated. From the context menu select **Update from v2c file** and select the file from its storage location. After updating a Hardkey/Softkey you may use the **Refresh key data** function in the context menu to display the updated license information.
Chapter 1  Safety directions

The TSP system concept is designed for performing seismic measurements in tunnels. There are inherent dangers in working in this environment. There are also some safety measures regarding the TSP system. It is essential to read these safety instructions carefully.

It is essential to consider the local tunnel safety regulations as well as the safety regulations in this manual!

The following directions should enable the person responsible for the TSP system and the operator to anticipate and avoid operational hazards. The person responsible for the instrument must ensure that all users understand and obey these directions. Read this manual and the manuals of accessories carefully before you activate the instrument.

1.1 Disclaimer of liability

It shall be noticed, that the TSP system on the whole and each single component of the TSP system holds no intrinsic safety for use in potentially explosive atmospheres. It means that all TSP devices are not tested and consequently certified according to ATEX CE compliance or other relevant directives on the incapability of igniting flammable gases or fuels, e.g. Methane, by releasing sufficient electrical, electrostatic, electromagnetic or thermal energy. Any liability for direct or indirect loss or damage (notably but not exclusively loss of profits and claims by third parties) which may arise as a result of the non-fulfilment of AT’s contractual obligations and/or as a result of the operation, and/or the operational breakdown of any TSP system component supplied by AT is hereby expressly excluded. In no event shall AT be liable for incidental or consequential damages, even if AT shall have been given notice of the possibility of such damages being claimed.

1.2 Use of instrument

1.2.1 Intended use of instrument

The TSP system is designed and suitable for the following applications, within the limits of its intended conditions of use:

- Measurement of seismic waves generated by explosives in the rock mass around a tunnel.
- Recording and digital storage of the seismic wave signals on a control computer.

1.2.2 Prohibited uses

- Use of the instrument without instruction.
- Use others than the recommended applications for which the instrument is intended.

1.2.3 Limits of Use

Environment:

Suitable for use in an atmosphere appropriate for permanent human habitation: not suitable for use in aggressive or explosive environments.

Local authorities and safety experts must be contacted before working in explosive areas, close proximity to electrical installations or any similar hazardous situations.
1.2.4 Prohibited modifications

All changes, modifications or conversions of the product are prohibited in order to fully comply with the law. Changes could void the user's authority to operate the equipment.

1.2.5 Danger working within tunnel environment

It is essential to consider the necessary safety regulations of the security administration and take all appropriate measures. Dangerous situations can arise through work in tunnels, for example:

- Moving construction site vehicles
- Items thrown up or fallen down by passing vehicles.
- Electric current flow through lines.
- Oxygen deficiency.

The above is not a complete list of dangers. The TSP system should only be used by persons who are authorised by the responsible person and when all safety precautions are being observed. The manufacturer/supplier does not take any responsibility for the safe operation of the equipment.

1.2.6 Other dangers

The TSP system contains parts and devices which are operated by the user. With intended use the following references must be considered:

- During drilling bore holes and installation of the receiver, avoid placing any part of the body (e.g. fingers) between working tools (e.g. bore hammer, bore jumbo, etc.) and installation tools.
- Single boxes of the TSP system can weigh up to 12 kg. However, incorrect lifting technique can cause back pain or associated problems. Consider the maximum lifting limits and get help if required.
- The TSP system is supplied with rechargeable batteries. Inappropriate use of the battery may lead to an explosion. Consider the warnings and manuals for the correct handling of the batteries. Only use batteries according to specifications of Amberg Technologies.
Chapter 2  TSP 303 Plus system components

The TSP 303 Plus system configuration consists of the items as shown in the figure below. For a more detailed specification of each component please refer to the TSP 303 Plus Data sheet.

Figure 1. TSP 303 Plus system package

A  1 case Recording Unit
B  2 cases Receiver Units
C  1 case Accessories
D  2 bags Receiver protection tubes & installation tubes
E  4 packages, each two with TSPdowel and SeisBond® cartridges
Figure 2. TSP 303 Plus system components at a glance

1. Recording Unit
2. Panasonic Toughbook with data upload cable

3. Receiver Unit case containing:
4. 2x 20 m Receiver cables on drum
5. Jaw wrench
6. Cable drum holder
7. Installation tool
8. 2 Receivers
9. Knitting-latex gloves

9. Accessories case containing:
10. 3 m Folding meter
11. 20 m Trigger cable on drum
12. 50 m Shooting cable on drum with removable cable drum holder
13 Multi tool
14 LED Lenser torch
15 Laser DistoMeter
16 Electronic level
17 Charger for Panasonic Toughbook
18 Charger for Li-Ion battery of Recording Unit
19 Multifunctional Trigger Box

20 2 Installation tubes
21 4 Protection tubes
22 Telescopic tamping rod for SeisBond® cartridges
23 cartridge charger (attached to tamping rod)
24 SeisBond® cartridges
25 TSPdowels

Due to export regulations and restrictions the blasting machine is not part of the TSP system and must be purchased or provided by the client. Furthermore, all explosives and detonators have to be provided by the client or customer with strict regard to relevant local safety regulations.
Chapter 3 Preparing a TSP measurement

3.1 General

The sketch below shows a typical shot line. Usually, data acquisition can be carried out with a single shot line arranged on either side of the tunnel. As shown below, the shot line is on the left side looking towards the face since possible fault planes are anticipated to strike the tunnel from the left side first. In order to gain more data, which might become necessary in complex geologic conditions, it is useful having a second shot line on the opposite side. However, using only one shot line and four receiver units is more economical. Even when the geology is not known in terms of preferred strike directions, the positioning of receiver units on both sides of the tunnel will provide a sufficient 3D-image in normal geology.

![Figure 3. Specifications of TSP measurement layout](image)

3.2 Marking of the measurement layout

Having decided the investigation layout according to the anticipated strike direction the positions of the receiver and shot holes have to be defined. Apart from special cases the standard layout should be used and the following procedure is recommended:

1. Determine the chainage (Tunnelmeter) of the tunnel face at time of TSP measurement.
2. Define the shot hole position that is closest to the tunnel face (S24). Depending upon the accessibility at the side wall in front of the tunnel, the closest shot hole should be one to five meters from the tunnel face or as close as possible to the face in case of TBM operation.
3. Based on the shot hole closest to the face (S24), define the remaining 23 shot hole positions (S23...S1) at the same level with a 1.5 m spacing.
4. Move further 15 m from shot hole position S1 and define the front receiver hole position (e.g. RCV FL) at the same level.
5. Move further 5 m from front receiver hole position (e.g. RCV FL) and define rear receiver hole position at the same level (e.g. RCV RL).
6. Define the remaining two receiver hole positions on opposite tunnel side walls at same level (e.g. RCV FR and RCV RR).
The shot hole interval should be 1.5 m. For imperative reasons, e.g. due to lack of space or obstacles at the side wall, a variant shot hole spacing may become an option. In any case, single intervals should be in the range of 1.2 to 2 m. In case of insufficient space for the required total shot-receiver hole layout, make sure that the required number of 24 shot holes is held by defining smaller shot hole spacings respectively. If the option of shorter intervals is impossible, ensure at least a minimum number of 18 shot holes.

The alignment of receiver and shot bore holes should comply with the specifications given in the following table.

**Shot bore hole (S)**
- Number: 24, all along one tunnel wall side
- Diameter: 38 - 45 mm
- Depth: 1.5 m in solid rock
- Horizontal angle: perpendicular to the tunnel axis
- Vertical angle: 15-20° downwards from horizontal (because of water tamping of explosive charges)
- Height: 1.20 - 1.60 m from invert (all same level)
- Position: Starting at 1 - 5 m from the tunnel face or as close as possible to the face in case of TBM operation; 1.50 m spacing

**Receiver bore hole (RCV)**
- Number: 4, two each on opposite tunnel sides
- Diameter: 50 mm
- Depth: 2.00 - 2.05 m
- Horizontal angle: perpendicular to the tunnel axis
- Vertical angle: 5-10° upwards from horizontal
- Height: 1.20 - 1.60 m from invert (all same level)
- Position front RCV: 15 m from face most far shot hole: one each on opposite side walls
- Position rear RCV: 5 m from front receivers: one each on opposite side walls

### 3.3 Drilling and protecting bore holes
Drilling shot holes in unstable rock mass formation may cause a collapse of the holes after a certain time. To prevent this, a thin-walled plastic pipe (external diameter approx. 30 mm, length approx. 1.5 m) can be used to temporarily support the hole. The shot charges can be pushed through the pipe whilst slowly removing it. This should be carried out just before shooting. The pipes may be used again for the next TSP measurement. If the rock formation is very unstable, however, and the protecting pipe cannot be removed, it is possible to shoot through the pipe.

Protect the shot holes with thin-walled plastic pipes to temporarily support the hole in unstable rock formation.

### 3.4 Check list of required items

**Blasting Machine**
- Electrical HI-blasting machine, Voltage outlet of 1000V - 1500V, Capacity 40 µF - 80 µF
<table>
<thead>
<tr>
<th>Items</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>Explosives</td>
<td>30 pcs. of detonating cord (PETN) or gelatinous w/ detonation velocity &gt; 6000 m/s, 50-150 g /piece</td>
</tr>
<tr>
<td>Electric Detonator</td>
<td>30 pcs., highly insensitive, delay interval: 0 (instantaneous)</td>
</tr>
<tr>
<td>Thin plastic tubes (PVC etc.)</td>
<td>For shot holes to prevent drill hole collapse (optional)</td>
</tr>
<tr>
<td>Water supply</td>
<td>Water hose for tamping of the shot charges</td>
</tr>
<tr>
<td>Compressed air</td>
<td>Useful to remove water or pebbles from bore hole</td>
</tr>
<tr>
<td>Cushion of geo-textiles</td>
<td>May prevent damage from blow-out (1 x 1 m) (optional)</td>
</tr>
<tr>
<td>Marking spray, red</td>
<td>Starting at 1 - 5 m from the tunnel face or as close as possible to the face in case of TBM operation; 1.50 m spacing</td>
</tr>
<tr>
<td>Tape measure</td>
<td>Preferably 50 m length</td>
</tr>
<tr>
<td>Normal lights</td>
<td>Possibly 1 or 2 spotlights</td>
</tr>
</tbody>
</table>
Chapter 4 Performing a TSP measurement

4.1 Measuring of the layout geometry

After all required bore holes have been drilled, it is necessary to measure the exact positions, depths and angles of all bore holes. At this, absolute geographical coordinates are not required nor desired. The TSP related coordinate system is a left-handed Cartesian coordinate system (X, Y, Z), where X-direction is in heading direction, Y-direction is to the right side and Z looks up. Its origin is defined by the TSP reference point (REF). It is absolutely necessary to follow the subsequent guidelines in order to take the geometry correctly.

1. Each TSP measurement usually performed at a certain tunnel face station is called campaign. Each campaign has one reference point (REF) lying on the tunnel axis that is defined as the axis on the invert dividing the tunnel width into two equal parts. The position of REF along the tunnel axis is user-defined. In any case, it needs to be defined behind all bore hole positions used for the current campaign. It could be some small distance behind the rearmost receiver position; preferably it is at the rearmost receiver position. The position of REF gives the relation between the local TSP coordinate system and the stationing within the tunnel project. Hence, it is required to know the REF position in Tunnelmeter.

2. In order to enter all receiver (RCV) and shot hole (S) positions and depths easily, the operator doesn't need to consider Y-coordinates, which are computed by Amberg TSP Plus software automatically using the entered tunnel profile at REF position. The remaining values X- and Z-coordinates to be measured for each bore hole are defined by the Distance from REF along tunnel axis (X) and Height from REF (Z), which is the level from invert, if REF is at the invert.

3. After having measured the position of the bore hole given by the values of Distance and Height, the depth of the bore hole need to be measured as the value of Depth. Since the bore holes can be considered as rather horizontal holes - without neglecting vertical angles - the Depth values contribute to the Y-coordinate. Amberg TSP Plus software consider the sign of the contribution to the Y-coordinate by the selection of the tunnel wall side.

4. In addition to the bore hole depths, the operator needs to measure the vertical angle and in case the horizontal angle.

5. Measuring of Tunnel profile resp. tunnel height and width!

Major steps in the bore hole level (height difference > ±1m) should be avoided. Also, it should be avoided that the transition from bench heading to crown heading intersects the campaign layout.
Figure 4. Geometrical situation of a TSP measurement layout with geometry input parameters

**Tunnel wall** (left or right) - Location of receiver and shot holes along left or right tunnel wall.

**Dist. to REF** (distance to reference) - Horizontal distance along side wall from receiver or shot hole to the Reference point (REF). Dist. to REF values have to be always positive.

**Height to REF** (height to reference) - Vertical distance from receiver and shot bore holes to the reference point (REF).
Depth

Depth of tri-axial sensors or explosive charge. The depth values may be less than the drilled bore hole depth for receiver and shot holes depending on depth accessibility. Depth values are measured always as positive values. Amberg TSP Plus software will assign depth values to selected tunnel wall.

Vertical angle

Upward or downward inclination of bore holes. Upward inclination is positive and downward inclination is negative. This convention is valid for left and right tunnel wall.

Inclination angles range from -90° < 0 < +90°.

Twist angle

Angle of rotation around the receiver’s longitudinal axis. If the longitudinal axis of the receiver is twisted towards the Face, the twist angle is positive. In the other case it is negative.

Twist angle range from -180° < 0 < 180°.

Horizontal angle

The angle is defined as the horizontal deviation of bore holes from the perpendicular to the Reference axis in the horizontal plane. If the bore hole deviates towards the Face, the angle is positive. In other case, the angle is negative.

Horizontal angles range from -90° to +90°.

In case the horizontal angle can’t be taken directly and it can be calculated from measured triangle legs (see Calculated HA).

Calculated HA

(calculated horizontal angle) - Alternative method to determine the Horizontal angle by measuring triangle legs with a distometer.

Figure 5. Calculated HA of bore holes (plan view)
- Put a longer stick or bar into the bore hole.
- Place your distometer about 2m in face direction at the bore hole height level.

Measure the following legs:

- **Measured wall leg** - Measuring length along the tunnel wall. Distance from measuring point to bore hole at tunnel wall of receiver or shot hole.

- **Measured drill leg** - Measuring length in direction of bore hole extension. Distance from measuring point to bore hole at tunnel wall of receiver or shot hole.

- **Measured tip leg** - Measuring length between wall leg and drill leg point.

It is recommended to fill out the TSP 303 Seismic layout & recording sheets. You can find them in the program folder Amberg TSP Plus / Documentation of the Windows Start menu. Feel free to print out for the next measurement.
4.2 System setup

Before starting the campaign's data acquisition, make sure that the batteries for both the Recording Unit and the Panasonic Toughbook have been fully charged (chapter 5: System maintenance).

4.2.1 Assembling receiver

The installation of the receiver unit should be carried out as follows:
Performing a TSP measurement

Step 1: Screw 2 receiver protection tubes together (items 21).

Clean both fittings from mud and small stones before assembling.

Step 2: Screw the installation tube together with the receiver protection tubes (items 21).

Step 3: Take receiver (item 8) and TSPdowel (item 25). Screw TSPdowel hand-tight to sensor part of receiver.

Step 4: Put one jaw wrench on the square sleeve of the receiver and the second wrench on the TSPdowel and twist the TSP dowel until you reach the optimum torque. The required torque is obtained when the clamping spring is bent and the two jaw wrench parts sides collide with each other.

The required torque is obtained when the clamping spring is bent and the two jaw wrench parts sides collide with each other.

Proper torque is necessary to reach optimum coupling between the TSP-dowel and the sensor head.
Step 5: Take assembled tube and push the receiver from the socket part side (marked with red stripe) through the assembled tube.

Step 6: Plug the TSPdowel into the female fitting of the protection tube.

Step 7: Attach the installation tool (item 7) to socket part of receiver. Only one mounting position is possible: the red dot of the receiver installation tool has to be in line with the red marked stripe of the socket part of receiver.
Step 8: Screw the nut of the installation tool until the receiver system is slightly stretched.

Step 9: Repeat Step 1 to 8 for all receivers to be used for measurement.

4.2.2 Checking receiver bore holes

Before receiver installation, it is recommended to check the bore holes on depth and hole caliber. The telescopic tamping rod (item 22) and cartridge charger (item 23) can be used for this check.

⚠️ If the tamping rod does not reach the bore hole foot, do not try to insert the assembled receiver. Otherwise it may happen that the receiver and TSPdowel get stuck and you will not be able to obtain good data quality by optimum sensor coupling.

ℹ️ Optimum bore hole depth for setting the receiver is 2.05 m. If bore hole is deeper, insert additional SeisBond® cartridges to reduce depth. 1 SeisBond® cartridge reduces the depth of about 10 cm.
Step 10: Attach cartridge charger (item 23) on head of telescopic tamping rod (item 22).

Step 11: Extend the three-part telescopic tamping rod to a length of approx. 2.20 m and tighten the connection sleeves slightly.

Step 12: Check the bore hole condition with the LED Lenser torch (item 14). The bore hole should be clean and free of drilling cuttings. Otherwise it may happen that the receiver and TSPdowel get stuck.

⚠️ The bore hole should be clean and free of drilling cuttings. Otherwise it may happen that the receiver and TSPdowel get stuck.
**Step 13:** If the bore hole is free, insert the tamping rod and check caliber and depth.

**Step 14:** Insert tamping rod to the foot of bore hole. The tamping rod must be free to move without interlock. The required receiver bore hole depth is 2.00 to 2.05 m.

**Step 15:** Measure the bore hole depth with the folding meter (item 10). The bore hole depth should not exceed 2.05 m.

⚠️ In case of a bore hole depth between 2.10 m and 2.20 m, insert a SeisBond® cartridge to shorten the bore hole depth according to step 15 to 21.

Repeat step 12 to 14 for all receiver holes to be used.

### 4.2.3 Setting the receiver

Before the receiver insert, a SeisBond® cartridge has to be placed to the bore hole foot shortly before. Due to the curing time of the mortar the subsequent steps should be carefully followed.
Use only SeisBond® cartridges provided by Amberg Technologies AG, Switzerland. The SeisBond® is a specially designed mortar with optimum performance combining flow characteristics, short curing time, no shrinkage and optimized signal coupling. While handling the SeisBond® cartridges, wear working gloves! For more information refer to SeisBond® Safety Data Sheet delivered with the cartridge package.

**Step 16:** Cut the SeisBond® bag open along the marked line (item 25).

**Step 17:** Fill up bag with clean, cold water.

Use only clean cold water. Contaminated water (e.g. by oil) reduces the performance quality of the SeisBond® mortar.
Step 18: Knead the bag for approx. 30 seconds slightly until water is suck up by the mortar. You may have to refill with water, if the mortar doesn't feel saturated.

Step 19: Take the cartridge out of the bag.

⚠️ After watering the cartridge the setting time of receiver is only 5 min. The SeisBond® cures within 10-15 minutes depending on temperature and water content inside bore hole.

Step 20: Place soaked cartridge onto the charger of the already assembled tamping rod.
**Step 21:** Carefully insert the cartridge with the tamping rod into the receiver bore hole. Be aware, that the cartridge will not be damaged during insertion and mortar will be lost on its way to the bore hole foot.

**Step 22:** Insert the tamping rod to the bore hole foot. Place the cartridge by twisting the tamping rod half turn. If the cartridge is placed, pull out tamping rod.

**Step 23:** Take already assembled receiver and insert it into the bore hole until you feel resistance by the mortar.
Step 24: Screw the receiver into the mortar by using the levers of the installation tool. Screw only clockwise until the TSPdowel is seated firmly into the mortar.

⚠️ Maximum of 2-3 full turns are sufficient to place the dowel inside SeisBond® mortar. Turn in maximum until you feel resistance.

⚠️ **DO NOT TURN FURTHER, IF YOU FEEL STRONG RESISTANCE, EVEN IF RECEIVER IS NOT HORIZONTALLY ALIGNED!**

MORE TURNS MAY DAMAGE RECEIVER.

Step 25: Align the sensor by turning in clockwise direction; never turn counter clockwise. Align the spirit level horizontally using the installation tool. The arrow and FACE markings close to the spirit level must point towards the face. In case of strong resistance, do not turn further and keep current position.

Step 26: Remove the cap on the socket segment and connect the receiver unit with the receiver cable (items 4, Lemo plug with blue or red kink protection). Connect the opposite plug of the receiver cable with one of the receiver sockets of the Recording Unit (marked RECEIVER on front panel).
Step 27: After fixing the packer measure the twist angle with the Electronic Level (item 16) and fill in the recording sheet.

Step 28: Push the damping plug into the bore hole mouth.

Step 29: Repeat steps 16 to 28 with the remaining receiver.

⚠️ Make sure that the cables don't cross power lines, transformers and other sources producing strong electromagnetic fields and noise signals. In order to avoid inductive coupling it is absolutely necessary to unwind all the loops of the receiver cable from the cable drum.
4.2.4 Connecting Toughbook with Recording Unit

Connect the data upload cable with the USB socket on the front panel of the Recording Unit and the USB port of the Toughbook PC. Switch on the Toughbook and login to the MS Windows operating system.

![Figure 7. Font panel view of the TSP 303 Plus Recording Unit](image)

4.2.5 Checking battery charge

Switch on the Recording Unit by pressing the switch. The status of the battery charge is indicated by an illuminated ring in the switch. If the Recording Unit doesn't switch on, the battery voltage is below 10.4 Volt. In this case, charge the battery first using the Recording Unit battery charger. Connect the charger to the front panel input socket "12 VDC IN".

A fully charged battery allows for minimum 10 hours operating time in recording state. For your understanding, during data acquisition, the Recording Unit is in the idle state between the single shot recording, since the recording state "Ready for Recording" is switched on shortly before each blasting only.

The following table describes the different of battery charge status indicated by the illuminated ring of the switch.

<table>
<thead>
<tr>
<th>Illumination status of switch</th>
<th>Battery charge status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Recording Unit is switched off.</td>
<td></td>
</tr>
</tbody>
</table>
Recording Unit is switched on.

Battery capacity in idle state of Recording Unit: > 55 %

Battery capacity in recording state of Recording Unit: > 65 %

or

charger for Li-Ion battery is connected.

Recording Unit is switched on.

Battery capacity in idle state of Recording Unit: > 25... 55 %

Battery capacity in recording state of Recording Unit: > 40... 65 %

If the indication of idle state is given, please prepare charge the battery or replace with a fully charged battery or connect a fully charged external battery to front panel input socket "12 VDC IN" within a short time.

Recording Unit is switched on.

Battery capacity in idle state of Recording Unit: > 15... 25 %

Battery capacity in recording state of Recording Unit: < 40 %

If the indication of idle state is given, please immediately charge the battery or replace with a fully charged battery or connect a fully charged external battery to front panel input socket "12 VDC IN".

In case an external battery is connected to the Recording Unit, the illuminated ring is blinking. The status described above apply here as well.

4.2.6 Use of external batteries

Connecting and removing external battery pack, power supplies and chargers during the measurement create unwanted signal peaks on the recordings. Hence, avoid this.

When the external battery charge falls below the minimum voltage during the measurement, the Recording Unit switches automatically on the internal battery. The switch can cause unwanted signal peaks during recording. At idle, the external battery recovers and the Recording Unit may switch back to the external battery. These forth and back switching cause peak signal every time. Hence, better disconnect the discharged battery.

4.2.7 Seismic noise test

The Amberg TSP Plus software automatically carries out a seismic noise check of the receiver units before recording of each shot. It checks the functionality of the sensors and presents the results as a bar chart. For the further procedure of the Noise Check refer to section “Seismic data acquisition” in this manual.
4.2.8 Trigger/Shot test (Trigger mode Standard)

The trigger test serves to check the trigger and the blasting machine before starting the campaign. Therefore make the following connections:

1. Connect the Recording Unit with one plug of the trigger cable (item 11, yellow kink protection behind each plug) using the TRIGGER input socket.
2. Connect the opposite plug of the trigger cable with the Multifunctional Trigger Box (item 19) using the Rec. Unit input socket.
3. Connect the Trigger Box with the blasting machine using the open ended 2-wire cable of the Trigger Box.
4. Connect the test resistor (that simulates the blasting cap) with the Trigger Box outlet (banana screw sockets). Alternatively, for a real test shot with a blasting cap, connect the 2-wire 50 m long shooting cable (item 12) with the Trigger Box outlet and the wires of the blasting cap.
5. Enter into the Noise Check dialog of the Amberg TSP Plus software (see section “Starting data acquisition”). At the Trigger Box, the green light turns on. Now, a test shot is ready to be fired and recorded.
6. The blasting machine should be charged and the signal "READY " for firing a seismic shot (single shot detonation!) is given by the operator and indicated by a green light on the trigger box. For safety reasons the final decision on the blast is with the blasting master. However, the trigger circuit inside the trigger box will provide a precise start of the recording and as the recording starts the green light switches off immediately. During the recording time, the red control light on the trigger box is on (usually for a very short time).

After successfully triggering and recording, the seismic data will be uploaded from the Recording Unit to the memory (RAM) of the Toughbook. The recorded test data will be shown as seismic traces in a new display replacing the Noise Check display (see section “Data recording”). Because this is a test “shot” no real seismic signal has been generated. Only seismic traces containing random noise of very small amplitudes are visible when the Cross Normalize function is selected (this function will be explained in section “Data recording”).

Instead of a test resistor it is also possible to use a blasting cap in the shot hole next to the receiver unit (assuming the bore hole is stable). In this case, it is possible to control the quality of the signal. The travel time of the signal from shot to receiver can be measured by show value function in the shot data viewer of the Acquisition wizard. With $X_{S1}$ = Distance shot hole – receiver and $V_p$ = Seismic P-Wave velocity, the travel time should be $T_{S1} = X_{S1}/V_p$. For example, with a distance of $X_{S1}$=20 m and an estimated P-velocity $V_p$ of 4000 m/s the resulting travel time is 5 ms.

Principally, the test recording is identical to the production recording, but the displayed data should not be stored in the campaign file. The operator can carry out as many tests as necessary. After having successfully completed the trigger test, the entire TSP 303 system is ready for recording the campaign.

4.2.9 Charge configuration

In order to succeed high signal amplitudes explosive material with high effectiveness is required. It is strongly recommended to use charges with normal to high explosiveness of minimum 5'600 m/s detonation speed. Depending on given rock mass conditions the charge sizes have to be adapted to avoid overclipping signals. Generally, lower charges leads to an optimum seismic signal in harder rock while softer rock requires higher charges.

A possible charging configuration for a TSP hard rock application could be:
4.2.10 Detonator preparation & system setup

The following table lists the types of detonators supported by Amberg TSP 303 Plus:

<table>
<thead>
<tr>
<th>Type of detonator</th>
<th>System setup</th>
</tr>
</thead>
<tbody>
<tr>
<td>Highly insensitive electric detonators with delay interval: 0, instantaneous</td>
<td>Standard</td>
</tr>
<tr>
<td>Electrical detonators with any delay</td>
<td>Wire Break</td>
</tr>
<tr>
<td>Electronic detonators with any delay</td>
<td>Wire Break</td>
</tr>
<tr>
<td>Nonel detonators with any delay</td>
<td>Wire Break</td>
</tr>
</tbody>
</table>

For Standard system setup refer to:

Section 4.2.10.2, “Standard system setup” on page 41

For Wire Break system setup refer to:

Section 4.2.10.3, “Wire Break system setup” on page 42

Depending on the available detonators individual trigger box and acquisition setups have to be selected (see Section 4.3.4.2, “Wizard 1: Recording setup” on page 50).

The handling of any kind of explosive material, exploders and the ignition of those are only allowed by advised and certified shooting masters. The following measures must be strictly observed during the preparation of shot charges and during the entire campaign.

4.2.10.1 Multifunctional Trigger Box

The Multifunctional Trigger Box allows to perform TSP measurements independently of the type of detonator. Instantaneous or delay detonators can be used as is the rule at construction site. The principle is that triggering of the recording starts in the moment of detonator’s firing instead of shot ignition by the blasting machine.
Cabling sockets:

1. **Blaster w/ Inst. Det.** Connection cable to blasting machine
2. **Trigger Switch** Socket for sensor trigger cable
3. **Rec. Unit** Socket for trigger cable to Recording Unit
A. **Instant. Detonator** Wire IN/OUT sockets for instantaneous detonators
B. **WBT Wire** Wire IN/OUT sockets for Wire break

Controls:

- **R1 Ready for Rec.** The LED lights up, if the acquisition mode of the TSP Recording Unit is active and ready for recording.
- **R2 Recording** The LED lights up, if recording is being triggered by ignition of the detonator. The LED lights while the unit is recording according to the selected recording length.
- **W1 WBT Ready** Lights up green when Wire break trigger box is active (only if Wire Break trigger mode is activated).
W2 WBT Wire OK

The LED lights up, if the breakwire is connected to the Multifunctional Trigger Box and the connections are ok.

4.2.10.2 Standard system setup

![Diagram of standard system setup]

Figure 9. Principle of standard system setup using highly insensitive detonators with delay interval: 0

Ensuring a riskless work, following steps should be followed.

Before charging the shot hole:

- disconnect the two detonator wires (A) from the Multifunctional Trigger Box sockets (A: Instant. Detonator)
- disconnect the blasting machine (1) from the Multifunctional Trigger Box (1: Blaster w/ Inst. Det.)

During charging the shot holes:

- connect the detonator with the explosive charge without any connection to the detonator wire (A)
- charge the shot hole
- fill up the shot hole with water

Preparing the measurement:

- connect the two wire ends of the detonator with the detonator wires (A)
- move away from the shot hole
- connect the detonator wires (A) with the Multifunctional Trigger Box sockets (A: Instant. Detonator)
- connect the blasting machine (1) with the Multifunctional Trigger Box cable

Starting the measurement:
- start the acquisition wizard within Amberg TSP Plus
- select Trigger mode "Standard"
- Go for recording (-> if ready, the green light (R1) at the Multifunctional Trigger Box is switched on)
- charge the blasting machine by blasting engineer
- ignite the shot by blasting engineer
- Recording Unit is collection data after shot ignition and successful triggering (light R1 switches off while light R2 switches on for the time of recording

After the measurement:
- accept or reject recording
- GO ON WITH STEP „Before charging the shot hole” FOR THE NEXT SHOT

If there are no safety restrictions, loading all shot holes can be done during the setup and testing of the TSP equipment in order to save time.

4.2.10.3  Wire Break system setup

![Diagram of Wire Break system setup using detonators with any time delay]

Figure 10. Principle of Wire Break system setup using detonators with any time delay

Ensuring a riskless work, following steps should be followed.

Before charging the shot hole:
- disconnect the two detonator wires (A) from the Blasting machine (1)
- disconnect the "Wire Break" cables (B) from the Multifunctional Trigger Box B
- connect the Trigger cable (3) between Recording Unit and Multifunctional Trigger Box 3

**Preparing the detonator for Wire Break Triggering:**

- prepare the detonator with the Wire Break loop (see Section 4.2.10.5, "Wire Break loop preparation" on page 44).
- fix the Wire Break loop with tape to the detonator, firmly

**During charging the shot holes:**

- connect the detonator with the explosive charge without any connection to the de- nator wire (A) and any connection to the Multifunctional Trigger Box
- charge the shot hole
- fill up the shot hole with water

**Preparing the measurement:**

- connect the two wire ends of the detonator with the detonator wires (A)
- in case that non-electric detonators are used, connect the shock tube to the primer
- move away from the shot hole
- connect the Wire Break ends (B) to the Multifunctional Trigger Box sockets (B: WBT Wire)
- connect the detonation wires (A) with the blasting machine (1)

**Starting the measurement:**

- start the acquisition wizard within Amberg TSP Plus
- select Trigger mode "Wire Break"
- Go for recording (-> if ready, the green light at the trigger box is switched on)
- following lights turns on at the Multifunctional Trigger Box (B)
  - R1: Ready for Rec.
  - W1: WBT Ready
  - W2; WBT Wire OK
- charge the blasting machine by blasting engineer
- ignite the shot by blasting engineer

**After measurement:**

- accept or reject recording
- GO ON WITH STEP „Before charging the shot hole“ FOR THE NEXT SHOT

After shot is accepted or discarded shot data viewer opens with access to all stored shot records. Stored records can be recalled for comparison or checking the data stored on the Toughbook.
4.2.10.4 Charging shot holes

Charging (loading) the shot holes should be performed as follows:

1. Use a loading stick to check if the PVC pipe is free (not blocked).
2. Connect (detonating-cord) charge and blasting cap.
3. Push the charge down the hole through the PVC pipe using the loading stick.
4. Carefully pull out the PVC pipe (if possible) avoiding damage to the wires of the blasting cap.
5. For tamping reasons the hole has to be filled with water just before firing. A rubber hose with slowly running water is suitable.

If there are no safety restrictions, loading all shot holes can be done during the setup and testing of the TSP equipment in order to save time.

4.2.10.5 Wire Break loop preparation

The proper use of Wire Break trigger method needs additional preparation of a break wire mounted as a loop around the base charge of the detonator. At time the detonator's base charge explodes, the loop breaks and the system will trigger in its optimum immediately.

Mount the Wire Break loop only around the base charge of the detonator.

Wrong mounting of the Wire Break loop will lead to wrong trigger time. A loss of seismic data content is probable.

![Wire Break loop on a detonator](image)

It is required to prepare the Wire Break loop according to the following description steps:

**Required material:**

- Wire, single, 0.6 mm², Copper
- Tape

**Preparation of wires:**

1 wire for each detonator is necessary. Recommended length of wire is minimum 2.5 x bore hole depth. e.g. if bore hole depth = 2.00 m, the minimum wire length is 5.0 m.
For 24 detonators a minimum of 120 m wire is necessary.

Loop step 1: Take the prepared wire at it half length and form a wide loop.

⚠️ If not the half length is taken, the ends of the wire are unsymmetrical and one of then may be placed after charging inside the bore hole avoiding to connect it later on.

Loop step 2: Fold the wide loop on the wire and form two wings.

Loop step 3: Fold the two wings around the wire onto each other and form the loop.
Loop step 4: Take the detonator and place the loop around the base charge of it.

Loop step 5: Tighten firmly the loop around the detonator. The tightened loop needs to be placed in an area of 5 mm of the detonator front (location of the base charge).

⚠️ When firing, only the detonator tip at location of the base charge will be destroyed, breaking also the Wire loop. If the loop is not placed around the base charge area, it may not be broken (or broken at later time) which leads to wrong triggering.

Loop step 6: Fix the loop position with tape onto the detonator.

⚠️ Keep the loop position area of 5 mm of the detonator tip.

⚠️ The fixation of the loop is essential to hold the loop in position when in later steps the explosive charge with the detonator is prepared.
If there are no safety restrictions, prepare the loops before entering the tunnel in order to save undesired downtime.

4.3 Seismic data acquisition

The next few pages will describe the Amberg TSP workspace and basic functions, followed by the description of actual seismic data acquisition. It is assumed that the user is familiar with MS Windows terminology, operating conventions and basic mouse techniques. Start Amberg TSP Plus software the way you normally start Windows applications, i.e. double-click the program icon on the Desktop or click in the Start menu listing. The Amberg TSP Plus program starts up and presents you the Amberg TSP Plus workspace.

4.3.1 Amberg TSP Plus Workspace

The workspace is equipped with following windows:

- Project tree window
- Property window
- Processing monitor window

and the following features:

- Menu Bar contains various commands for operating Amberg TSP Plus.
- Tool Bar is made of individual buttons that provide a shortcut to the most commonly used Amberg TSP Plus commands. If the mouse pointer is positioned over a button a “tool bar tip” will appear to explain the purpose of the button. In addition, information concerning the functionality of the buttons will appear in the Status Bar.
- Processing monitor window
4.3.2 Amberg TSP Plus Menus & Tool bars

At program start, Amberg TSP Plus displays the general workspace containing the plain text Menu and graphical tool bar:

**Menu bar**
Actions can be performed using the mouse to select each command. Alternatively depressing and holding the Alt-key then the underlined letters for each step will accomplish the same action.

**File menu**
- **New Project...** create a new project file for data acquisition
- **Open Project...** open an existing project file
- **Recent Project...** open a project file from a list of previous edited projects
- **Options...** Charging (loading) the shot holes should be performed as follows:
  - **Preferences ▶ Language:** select application language
  - **Preferences ▶ Units:** define units & settings shown in application
- **Exit...** terminate the program

**View menu**
- **Project tree...** show or hide the project tree
- **Property window...** show or hide the property window
- **Processing monitor...** show or hide the processing monitor
- **Status bar...** show or hide the status bar

**Help menu**
- **Help - Amberg TSP Plus** opens HTML-based software manual
4.3.3 Starting data acquisition

Acquiring or recording new seismic TSP 303 data usually means creating a new campaign. There might be cases where you need to append additional data to an existing campaign. In this case open the existing campaign of existing project from the Menu bar.

The Amberg TSP seismic data acquisition is carried out in the Acquisition wizard window of the current campaign. Refer to the “Amberg TSP Plus Evaluation Manual” manual for more detailed information. The following describes the steps needed for data acquisition only.

The TSP 303 concept allows to manage several campaigns within a single tunnel project. It is recommended to organize all project related campaign in the same project.

Add Campaign in a new project

Starting a data acquisition in a new tunnel project a new project and campaign has to be created. Creating a campaign in new tunnel project should be performed as follows:

1. Create New Project... from main menu File ▶ New project....
2. Follow the new project wizard. After saving the new project the new project tree is available.
3. Add campaign... from project tree node Campaigns and follow the add campaign wizard editing campaign related information. (if information isn't available at time of creation, it can be later edited in the property window)
4. Open Acquisition wizard for data recording by double-click on acquisition node in project tree.

Add Campaign in an existing project

Additional campaigns can be added in the same project creating a new campaign in an existing project file should be performed as follows:

1. Open project from main menu File ▶ Open project... . The project tree with already performed campaign(s) opens.
2. Add campaign... from project tree node Campaigns and follow the add campaign wizard editing campaign related information. (if information isn't available at time of creation, it can be later edited in the property window)
3. Open **Acquisition** wizard for data recording by double-click on acquisition node in project tree.

### 4.3.4 Acquisition wizard

To begin acquiring data double-click on tree node **Acquisition** in the Project tree. A stand alone wizard opens guiding through parameter settings and the whole measurement.

#### 4.3.4.1 Wizard setting

**Theme:** Depending on tunnel illumination two different themes can be selected in order to improve visibility. The key shortcut **Alt+L** switches between black or white background themes. The current theme setting is saved automatically when leaving the wizard.

![Wizard setting image]

#### 4.3.4.2 Wizard 1: Recording setup

**Sample interval (frequency):** One of three sampling intervals can be selected via buttons. Either 20.83 μs (48 kHz), 41.66 μs (24 kHz) or 62.5 μs (16 kHz). Default sampling interval value is 20.83 μs.

**Recording length:** Selection of data length (ms) which can be uploaded from the Recording Unit to the Toughbook PC. Select either 500 ms or 1'000 ms by clicking the required radio button. Default number is 500 ms.

![Recording setup image]

- **To keep memory size of recorded data low we recommend to keep default settings.**
**Trigger mode:** The different trigger modes allow TSP measurements independently of the types of detonator. Instantaneous, delay, electric, electronic or Nonel detonators can be used as is the rule at construction site. The principle is that triggering of the recording starts in the moment of detonator’s firing instead of shot ignition by the blasting machine. Finally, high trigger accuracy is achieved. Depending on available detonators, the right trigger mode has to be selected to achieve correct triggering.

Default trigger mode is "Standard". The Wire break and Sensor trigger modes are license dependent selectable and inactive in case that no license is available.

<table>
<thead>
<tr>
<th>Detonator Types</th>
<th>Trigger mode selection</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Highly insensitive, delay</td>
<td>Standard</td>
<td>Electrical blasting machine, Voltage outlet of</td>
</tr>
<tr>
<td>interval: 0 (instantaneous)</td>
<td></td>
<td>1000V - 1500V, Capacity 40 µF - 80 µF</td>
</tr>
<tr>
<td>Electric, delay interval: 0</td>
<td>Wire break or Sensor</td>
<td>no requirements on blasting machine</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Wire break or Sensor trigger license necessary</td>
</tr>
<tr>
<td></td>
<td></td>
<td>only in combination with Multifunctional Trigger Box</td>
</tr>
<tr>
<td></td>
<td></td>
<td>preparation of Wire break loop necessary</td>
</tr>
</tbody>
</table>

It is absolutely necessary to use zero-delay electric detonators. Using delay detonators will end up in very imprecise first arrival time of each single shot resulting in incorrect velocity calculations of the seismic waves.

**4.3.4.3 Wizard 2: Receiver setup**

**Column "Receiver"**: Setting number of receiver and receiver names for number of installed receiver units. Available receiver units have to be defined to have them available for recording. Receiver names are editable. Add/delete functionality by using Add/Delete buttons. Default receiver names: RCV1, RCV2, new receiver.

**Column "Tunnel wall"**: A tunnel wall location has to be assigned to each receiver. The tunnel wall location has to be set for left or right location in the combo box. Default tunnel walls: RCV1(left), RCV2 (right), new receiver (right).
Check the receiver connected to the front panel and receiver names when assigning a tunnel wall in wizard. The proper tunnel wall to receiver name assignment is essential for the whole data processing. Offset calculations are based on these assignments. Wrong assignment will lead to incorrect processing and wrong results. (If wrong assignment was made, proper assignment can be corrected at any time in this wizard, the Shot data viewer of acquisition or in Receiver/Shot hole line editor. Refer to "Amberg TSP Plus Evaluation Manual" for detailed information).

It is recommended to use short, easy and distinctive receiver names. The receiver names will be shown for further identification throughout the whole processing.

4.3.4.4 Wizard 3: Shot holes setup

Column "Shot line": Setting of number for available shot lines. Available shot lines have to be defined to control the shot to shot hole assignment. Shot line names are editable. Add/delete Shot line functionality using Add/Delete buttons. Default shot line names: SL1, new shot line.

Column "Tunnel wall": A tunnel wall location for the shot line has to be assigned. The tunnel wall location can be selected either for left or right location in the combo-box. Default tunnel walls locations for shot lines: SL1 (right), new shot line (left).

Column "Shot hole": Setting of number for available shot holes for defined and selected shot line. Shot hole names are editable. Add/delete Shot hole functionality using Add/Delete buttons. Default shot holes: 1 to 24 each shot line.

It is recommended to use short, easy and distinctive shot line and shot hole names. The names will be shown for further identification throughout the whole processing.
4.3.4.5 Wizard 4: Hardware setup and Check

"Activate / Inactivate": You can switch receiver sockets ON/OFF by ticking the corresponding I/O buttons. The Wizard view correspond to receiver sockets at the front panel of the Recording Unit. Default selection: not active.

Selection box: Assignment of available receivers unit to active Recording Unit socket. List of in wizard 2 (Receiver setup) defined receivers. Data will only be uploaded from those channels which correspond to the active receiver sockets. Default selection: none.

Hardware status check: Each socket and connected receiver unit can be checked for malfunction. The status is displayed by green and/or red coloring.

⚠️ The activated sockets should always have status green. In case of any indication of malfunction, deactivate this socket and selected another correctly working socket.

<table>
<thead>
<tr>
<th>Status display</th>
<th>Meaning</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>■ receiver sockets not activated ■ no recording</td>
<td>- activate socket</td>
<td></td>
</tr>
</tbody>
</table>

Check electronic box

Status: Testing

- receiver socket activated for recording
- RCV not selected
- channels X,Y,Z green
- no data recording

Check electronic box

Status: NOT OK

- receiver socket activated for recording
- RCV not selected
- malfunction on e.g. channel Y
- no data recording

1.) deactivate this receiver socket
2.) activate other receiver socket
3.) contact Amberg Technologies for support
Check cabling & sensor  

**Status: OK**

- receiver socket activated for recording
- RCV selected
- receiver unit connected to socket
- no malfunction on components
- data will be recorded

---

Check cabling & sensor  

**Status: NOT OK**

- receiver socket activated for recording
- RCV selected
- receiver unit connected to socket
- malfunction on e.g. Z-component of sensor or broken receiver cable on Z-wire
- data will be recorded

1.) replace receiver cable and check again  

or  

2.) replace receiver unit and check again

---

Check cabling & sensor  

**Status: NOT OK**

- receiver socket activated for recording
- RCV selected
- no receiver unit connected to socket

or

- receiver cable broken

or

- or malfunction of sensor components
- data will be recorded

1.) check if receiver unit is connected to front panel socket  

or  

2.) check receiver cable and check again  

or  

3.) replace receiver unit and check again

---

4.3.4.6 Wizard 5: Shot setup

**Previous shot settings:** For further information about the previous shot settings are shown.
Next shot settings: Editor for setting next shot parameter as Shot line, Shot hole and Shot charge. Shot no. is automatically updated with the next one as it occurs.

It is recommended to edit carefully shot line, shot hole and shot charge assignment to next shot number information if available. Settings can be changed at any time directly after shot in shot data viewer or later on in Receiver/Shot hole line editor of main application.

4.3.4.7 Wizard 6: Noise check

Noise check: Noise displayed as colored lights indicating the actual signal level of each active working channel (sensor component) of each active receiver. The window allows fast access to current noise conditions in tunnel. Each bullet shows the instantaneous peak-level of the signal amplitude. The scaling on the bullet chart is logarithmic and starts with -120 dB (dynamic range of the system: min. -120 dB) with thresholds green (< -80 dB, 1 mV), yellow (-80dB, 1mV) to -70dB (3.16 mV) and red (>= -70 dB, 3.16 mV). The present noise values are displayed in -dB and mV.

For a functional noise check only, you can leave the noise check wizard and stop the communication between Recording Unit and Toughbook by clicking on Back. This is recommended if the operator or other components of the TSP 303 Plus system are not ready for recording. If you are not going to record immediately you should go back to previous wizard in order to save power of the Recording Unit. Notice that after leaving the noise check wizard the control lights switch off and indicate that there is no more power consumption for the time being. At any time you can easily re-enter the acquisition display.

Next shot settings: For further information the next shot settings are shown below present noise and are automatically updated.

Recording Unit status display initially reads "Go for recording" in yellow letters indicating the status of synchronization between software and Recording Unit. After a few seconds the status shows “Ready for recording” green colored and the green light READY on the connected trigger box lights up.
Performing a TSP measurement

The present noise level should not exceed -80 dB in average. Otherwise possible noise sources in the near tunnel environment should be eliminated.

4.3.5 Data recording

The standard recording operation for all 24 shots normally takes a total of about 30-45 minutes. During this period, source of seismic noise should be switched off if possible. For instance, advantage should be taken of work breaks, i.e. service breaks or shift changes.

It is possible to fire the shot points in any order as long as the correct shot point number can be correlated to its shot hole location (fill out the Field Recording Sheet). In order to avoid errors due to firing non-sequential shot numbers, it is advisable to shoot and record the shot holes with increasing or decreasing distance (offset) to the receiver. As previously described for the trigger test procedure, “live” recording follows the same way. Having all system components connected and successfully tested the Recording Unit is in the Ready status when the Recording Unit status is Ready for recording and the trigger box lights up green. The Noise Check dialog shows the system is ready for the next shot. At the moment of firing (with the blasting machine) the trigger box light turns red for time of recording length. The seismic data is recorded and uploaded to the Toughbook immediately after shot. During that time Recording Unit status switches to Upload data.... After all channels have been successfully uploaded, the display changes to the Shot data viewer, where all recorded traces are being presented, usually 6-12 traces from 1(X), 1(Y), 1(Z),..., 4(z).

4.3.5.1 Wizard 7: Shot data viewer (data upload)

The seismic traces are displayed immediately after uploading all working channels and their visualization can be modified by selection of the following controls:

**Shot selection & settings:** Information about currently recorded shot, like Shot. no., assigned Shot line and Shot hole, Shot charge and Magnitude of recorded signals.

**View settings:** For data check following settings are available: Normalization like Cross normalization, Trace normalization and Automatic gain control (AGC).

**Toolbar left:** Option for individual display settings such as zoom functionality (rectangle, all, in, out) and turn on/off trace value function.

**Toolbar right:** Option to switch between Shot view, displaying all recorded components of current selected (uploaded) shot no., or Component view displaying one component of all recorded shot. The Component view is not active in upload wizard.
Discard shot button: The Discard button will not save the data traces to a shot file. The program will ask you to confirm your discard decision a second time. Be careful since the data of this shot will be lost after the second confirmation. This function is useful for test shots and trigger tests or for any misfire which can happen due to a corrupt detonator or broken shooting cable. You may not want to save this data.

Accept shot button: The Accept button saves the displayed data traces to a shot file.

The maximum magnitude should be between 100 mV - 5'000 mV. In none of these cases, it is strongly recommended to use a higher or smaller explosive charge, respectively.

4.3.5.2 Wizard 8: Shot data viewer

After shot is accepted or discarded shot data viewer opens with access to all stored shot records. Stored records can be recalled for comparison or checking the data stored on the Toughbook.

Shot selection & settings: Information about currently recorded shot, like Shot. no., assigned Shot line and Shot hole, Shot charge and Magnitude of recorded signals.

View settings: For data check following settings are available: Normalization like Cross normalization, Trace normalization and Automatic gain control (AGC).

Toolbar left: Option for individual display settings such as zoom functionality (rectangle, all, in, out) and turn on/off trace value function.

Toolbar right: Option to switch between shot view, displaying all recorded components of current selected (uploaded) shot no., or component view displaying one component of all recorded shot. The component view is not active in upload wizard.

Next Shot button: Performing next shot. Shot setup (Wizard 5) opens for next shot hole assignment

Finish button: Leaving acquisition wizard and turn back to main application.
The shot data viewer can be opened at any time if stored data are available. Shot data viewer is not available before first shot is saved.

4.4 Dismounting the receiver

After data acquisition is finished, all receiver parts, except the TSPdowel, can be recovered.

**Step 1:** Disconnect the receiver cable and slip the cap onto the socket segment.

**Step 2:** Attach the **jaw wrench** to the square-part of the receiver socket element. Turn the receiver socket element left with jaw wrench until the sensor part of receiver is free from TSPdowel.

⚠️ It is required that the protection tubes are hold in position loosening the sensor part. This avoids any opening of protection tube fittings while turning the receiver anti-clockwise.
**Step 3:** Pull the receiver out of the protection tube and store it in the receiver case.

**Step 4:** Pull out the assembled tubes. Un-screw the tubes, clean them and store them in the shoulder bag.

**Step 5:** In case the fitting connections between the tubes are blocked and cannot be opened by hand, attach both jaw wrenches to the spare parts of the fittings and open by turning anti-clockwise.
Chapter 5  System maintenance

5.1 Charging Batteries

For a high availability of the TSP system we recommend to charge the battery and/or external battery after each use or at least every three months. Non-charging after use and longer storage may cause damages.

- Use only the supplied charger of TSP 303 systems or as spare part provided by AT. The use of unsuitable chargers may damage, fire or explosion of the battery.
- Do not charge batteries at environment temperatures < 0°C.
- High temperatures during loading, unloading and storage can reduce the lifetime of the battery capacity.
- Permanent storage of batteries only charged half full, and at cooler temperatures (15-20 °C).
- Full discharge reduces battery lifetime. It is recommended wherever possible to recharge early (at least when light at power button shows only the red light).

5.2 Cleaning of system components

The hardware of the TSP 303 Plus system has been developed for data collection in rough environmental conditions. In spite of precautions and careful handling of the equipment, it will not be possible to avoid pollution of dust, moisture, etc. on connections, the receiver units and other system components. For that reason, heavy dirt should be kept away in dusty or wet environment with plastic covers and all components of the system should be cleaned carefully using suitable tools. Caustic solvents should not be used.

To ensure a long life of your TSP 303 Plus system a full cleaning of all system components is required after each measurement. Do not use caustic solvents.
Chapter 6 Disposal

The TSP-System contains different materials, which must be disposed appropriately (based on country specific laws). Please observe the following minimum requirements:

6.1 Disposal of TSP components

- The electronic boards and cabling in the TSP Registration Unit, Accessories and receiver should be brought to an electronic scrap facility or sent back to below addresses sufficiently stamped by post.
- The front panel of the TSP Registration Unit, parts of receiver and accessories are made out of steel or aluminium. They may be recycled.

6.2 Disposal of batteries and accumulators

The user is legally obliged (battery regulation) to return used batteries and accumulators. Disposing used batteries in the household waste is prohibited! Batteries / accumulators containing hazardous substances are marked with the crossed-out wheeled bin. The symbol indicates that the product is forbidden to be disposed via the domestic refuse. After usage you can either turn in old batteries of SwissLevel, Leica Distometers or accumulators of Registration Unit with us at the below mentioned address sufficiently stamped by post. Consequently you comply with your legal obligations and contribute to environmental protection!

Free-of-charge take-back

Local: Please contact our local TSP distribution partner.
International: Amberg Technologies AG
Trockenloosstr. 21
CH – 8105 Regensdorf
Switzerland
Chapter 7 Declaration of Conformity

Declaration of Conformity
Konformitätserklärung
Déclaration de Conformité
Dichiarazione di Conformità
Declaración de Conformidad

We declare under sole responsibility that the product
erklären in alleiniger Verantwortung, dass das Produkt
declaraizemos sous notre seule responsabilité que le produit
dichiareriamo sotto la nostra propria responsabilità che il prodotto
declaramos bajo nuestra exclusiva responsabilidad que el producto
本声明仅此唯一对以下产品负责

TSP 303 Plus
with the modules
mit den Modulen
avec les modules
con i moduli
con los módulos

EN 61000-6-3: 2007 / A1: 2011
IEC 61000-6-3: 2006 / A1: 2011
EN 61000-6-2: 2005
IEC 61000-6-2: 2005

and following the provisions of directives
und die Bestimmungen der Richtlinien einhält
et conformément aux dispositions des directives
y conforme con le disposizioni delle direttive
y conforme con las disposiciones de las directivas

2014/30/EU (Electromagnetic compatibility EMC)
2011/65/EU (Restriction of the use of certain hazardous substances RoHS)

Date
Datum
Data
Fecha
日期
November 25, 2014
25. November 2014
25 novembre 2014
25 de noviembre de 2014
2014年11月25日

Marcel Kapermatten
Managing Director

Amberg Technologies AG
Trockenlocherstrasse 21
8105 Regensdorf-Watt
Switzerland
Phone +41 44 870 92 22
Fax +41 44 870 06 18
http://www.amberg.ch/ai